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Inventor 28.1 Inleiding 899

Inleiding

Theorie Iedere samenstelling die u maakt met Inventor kan achteraf
gebruikt worden voor een variant. Als bepaalde combina-
ties vaak voorkomen kunt u hier de samenstelling en de on-
derdelen op voorbereiden om het makkelijker te maken.

Excel  Als u de parameters van een samenstelling en zijn onder-
delen koppelt aan hetzelfde Excel bestand, dan kunt u deze
gelijktijdig wijzigen door het Excel bestand te wijzigen.

tPart  Als een onderdeel in een beperkt aantal varianten voorkomt
kunt u ook een iPart maken. In dat geval kiest u uit een
tabel de juiste variant. Dit is een voorgaande hoofdstuk
uitgebreid behandeld.
Als u dit onderdeel of iPart wilt gebruiken in verschillende
projecten, dan publiceert u deze naar de content center. U
kunt dan makkelijk een onderdeel uitwisselen voor een
andere variant.

tAssembly  Vanaf Inventor 11 kunt u een iAssembly maken. U kunt
' dan snel wisselen tussen een aantal varianten. In de iAssem-
! bly is onder andere opgenomen welke onderdelen enabled
ventor T zijn en welke rij van een iPart actief is. U kunt daarmee het
ene onderdeel uitwisselen voor een ander onderdeel en van
een onderdeel de juiste variant kiezen.

VANAF

Aan de ene kant kant een iAssembly krachtiger dan een
Excel koppeling, u kunt namelijk onderdelen onderdruk-
ken. Aan de andere kant kan een 1Assembly minder krach-
tig dan een Excel koppeling; u kunt namelijjk alleen kiezen
uit vooraf ingestelde lengten en niet variabele lengten.
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Excel

Theorie  Als bij een wijziging meerdere onderdelen tegelijkertijd
gewijzigd moeten worden, dan kunt u de parameters van
deze onderdelen met elkaar verbinden via Excel. Na een
wijziging van het rekenblad veranderen alle onderdelen.
Ook de samenstelling kan veranderen. In de volgende
afbeelding is deze procedure weergegeven.
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De parameters van een samenstelling kunt u niet alleen
koppelen aan een rekenblad, maar ook aan een onderdeel
(eng: Part). Helaas kunnen onderdelen onderling niet
gekoppeld worden. Gezien de beperking dat onderdelen
niet op deze wijze gekoppeld kunnen worden, lijkt het in
het algemeen beter om een rekenblad te gebruiken.
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Voorbereiding

U kunt dit hootdstuk alleen doorlopen als u hoofdstuk 4
over maatvarianten doorlopen heeft, zie blz: 141 en verder.

In de geleide instructie van dit practicum maakt u een teke-
ning van een hekwerk. De varianties die u gaat aanbrengen
zijn de hoogte en de breedte van het hek. Ook varieert u in
de afstand tussen de spijlen. De samenstelling bestaat uit
twee verschillende onderdelen, een horizontale ligger en
een spijl. Deze komen meerdere keren voor.

In de volgende afbeelding is de berekening uitgewerkt. De
spijlafstand is constant. Om het hek toch een bepaalde
lengte te geven wordt de afstand tussen de eerste spijl en de
rand en de laatste spijl en de rand gevarieerd. Als u een
variant aanmaakt met Excel, dan kost de uitwerking van de
berekening in het algemeen de meeste tijd.

Lengte

Spijlafstand Restwaarde (< SpijlAfstand)

|
10 0 001

Hoogte

|Horizonfaal |ptafsfaal 20 * S‘

LI Ll Ll Ll Ll . |Verticaal | rond 10 |

| Aantal Spijlen | AFRONDEN.NAAR.BENEDEN(Lengte/Spijlafstand;0) ‘
| Restwaarde | (Lengte-SpijlAfstand * (AantalSpijlen-1) ) / 2 ‘
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Het resultaat van het inventor model is een samenstellings-
tekening en stuklijst waarin de afzaaglengtes en hoofdma-
ten staan.
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Eerste onderdeel

Activeer het project waarin u werkt tijdens de cursus.

Start met een nieuw onderdeel op basis van millimeters.
Maak daarna de volgende schets. Dit is de doorsnede van
de horizontale ligger.

20—

L

Sluit de schets af.

Sla het bestand op. Noem deze ligger. (Doordat u het
bestand heeft opgeslagen in uw project staat de actuele
directory van Windows ingesteld op uw project. Als u nu
een Excel bestand wilt koppelen of aanmaken, dan wordt
direct gestart in de map van uw project.)

Activeer de functie om parameters aan te maken of te wijzi-
gen. Er verschijnt een venster met de parameters die Inven-
tor heeft gemaakt voor de schets.

Parameter Name Unit Equation Nomin.. | To Model E Comment

(JB=] Model Parameters |

do mm 120 mm 120,0000... | [20,0000... |7
\m mm 5 mm I5,000000 | [5,000000 [T
[userparameters
I™ Display only parameters used in equations Reset Tolerance
) Add Lk + ‘A‘ O| - ‘ Done

Klik op de knop om een de parameters uit een bestand uit
te lezen.
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Klik binnen het venster op de rechter muisknop. Kies uit
het menu dat verschijnt voor een nieuw Excel bestand.
In de volgende afbeelding is aangegeven waar u moet
klikken.

E)
a Sne\k oppeing

Eesn  Verplaatsen ongedaan maken CiriZ

e T —  —

ssssss Egenschappen

Er wordt een bestand aangemaakt met de naam “Nieuw
bestand.xls”

Klik op het bestand en druk op de functietoets F2. U kunt
dan de bestandsnaam veranderen.

Verander de naam naar Hekwerk.xls.

Klik op het bestand, zodat deze geselecteerd is.

Zoekenin: [ 5 cursus = cr B>

(E20idversions
Bestandsnaam:  [Helowerc s Openen
Bestandstypen: | Excel Fies (s} Annuderen
Start Cell AL  Link
 Embed
Klik op Openen.

Sluit het venster van de parameters.

Ga met de cursor naar de modelverkenner, klik op het
plus-teken voor 3rd Party en dubbelklik op het icoon voor
Hekwerk.xls. U kunt ook met de rechter muisknop op
Hekwerk.xls klikken en daarna uit het menu kiezen voor
Edit. Als u dit heeft gedaan wordt Excel opgestart.

Vul het eerste tabblad van het rekenblad in met de waarden
uit de volgende tabel. In de eerste kolom staan de namen
van de parameters. Merk op dat deze uit enkele woorden
bestaan. Spaties of vreemde tekens zijn niet toegestaan. In
de tweede kolom staan de waarden van de parameters of de
tormules. In de derde kolom staan de eenheden van de
parameters.
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Bij de Engelstalige
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=
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[ Lengte

| Done

Extrude E
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A B ( D
1 Lengte 300 mm
2 | Hoogte 450 mm
3 | SpijlAfstand | 100 mm
4 | AantalSpijlen | = AFRONDEN.NAAR.BENEDEN (B1/B3;0) | ul
5 | RestWaarde | = (B1-B3*(B4-1))/2 mm

Sla het Excel bestand op en sluit Excel.

Activeer de functie om de parameters te wijzigen. Als het
goed is, dan ziet u de parameters van Excel. Is dat niet zo;
Klik met de rechter muisknop op het excelblad. Kies voor
Delete en voeg het blad opnieuw toe.

Klik op de knop om zelf nog een parameter toe te voegen.
Noem deze parameter AfkortLengte. Let goed op de spel-
ling en op hoofd- en kleine letters. Tenslotte zijn die letters
van belang bij parameters.

Maak de parameter AfkortLengte gelijk aan de parameter
Lengte die uit Excel komt.

Zorg ervoor dat deze parameter geéxporteerd wordt.
Alleen dan komt de afkortlengte terug in de stuklijst.

Parameter Name Unit Equation Nominal Value Tol  Model Ecumment
=|Model Parameters
‘dn mm 20 mm |20,000000 @ [20,0000... |
‘.ﬂ mm 5 mm |5,000000 @ [s,000000 |
=/userParameters Y
Lams o Afkortleng g 00,000000 00,000
=H{c:\Documents and Settin.
Spijlafstand mm 100 mm 1007 100,000... (™
RestWaarde mm 50mm 50,000000 O |15000,0.. |
|AantalSpijlen ul I3 ul |3,000000 @ (3000000 |
Lengte mm 1300 mm [300,000000 @ [s00,000... 7
Hoogte mm 450 mm l450,000000 O [4s0,000... |
I Display only parameters used in equations Reset Tolerance
@ Add Link + |A| O ‘ - | Done

Controleer de invoer en sluit het venster.

Activeer de functie “Extrude” om een contour uit te
trekken.
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Zet de cursor op de waarde 10 mm en druk op de rechter
muisknop. Kies uit het menu dat verschijnt voor het
menu-item “List parameters”.

Kies de parameter Lengte. Als deze parameter niet
verschijnt in de lijst, dan is er iets fout gegaan met de
koppeling. U kunt dan het beste het menu-item “Tools >
Parameters™ activeren en de oude koppeling verwijderen en

opnieuw aanbrengen.

] (=1[E3)
|
shape |More |
il Prafile IE lm 0
Output ﬂ Lengte »
“FE] & |[n %%
I~ match shape
@I oK Cancel

Controleer de invoer en sluit het venster.

Maak een nieuwe schets bovenop de strip. Plaats daarna
een cirkel en bemaat deze. Gebruik voor de afstand tot de
rand de optie “List parameter” en kies de parameter
RestWaarde. Maak het gat net iets groter dan 10 mm,
zodat de spijlen van het hek er makkelijk in passen.

i ligger.ipt E@HE‘

d5 = 10,5 mm

f=t+——fx:d4 = RestWaarde—={

Activeer de functie Extrude en maak van de cirkel een gat
door de strip.

Activeer de functie voor rechthoekig patroon. Klik op het
gat en kies daarna de twee parameters “AantalSpijlen” en
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“SpijlAfstand”, zoals aangegeven in de volgende atbeelding.
Zorg dat het patroon de goede kant op loopt.

Pattern

Iy [resures
2|

Direction 1 Direction
N
Sl 3l | S
|spading =] || [5pacia = |

@ ok cancel | 2|

Controleer de invoer en sluit het venster.

Sla het onderdeel op.
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Tweede onderdeel

Maak een nieuw onderdeel op basis van millimeters. Teken
in de schets een cirkel en breng een maatvoorwaarde van
10 mm aan.

Activeer de functie om de parameters te tonen. Klik direct
op de knop Link en kies het bestand Hekwerk.xls. Negeer
de melding dat het bestand niet is opgeslagen. Klik daarna
op de knop Add en maak een nieuwe parameter aan. Noem
deze AfkortLengte, koppel deze aan Hoogte. Zorg ervoor
dat de schakelaar bij het exporteren van de parameter aan
staat. Controleer of u de naam AfkortLengte exact zo
geschreven heeft als bij het vorige onderdeel.

Parameters EE
: -~
Parameter Name Unit Equation Nominal Value To | Model E Comment

= |Model Parameters

10,000.. |

10,000000 @

10 mm

» kartleng 450,000000
= |Hekwerkads

Lengte mm 1300 mm 1300,000000 O [300,00.. (T
Hoogte mm 1450 mm 1450,000000 (O |450,00.. (T
|Spijlafstand mm 100 mm 100,000000 @ [w0,00.. |
|aantalSpijlen ul 3 ul 13,000000 @ [3,000000 |
RestWaarde mm 50 mm 50,000000 O |so000.. [ v
I Display only parameters used in equations Reset Tolerance
@ Add Link + ‘A Q‘ - ‘ Done

Extrudeer de cirkel over een afstand Hoogte, zoals in de
volgende afbeelding staat aangegeven.

Controleer het venster en sluit deze.

B
Shape \Mure |
M Profie ,E IT))::‘Z—;| 10
@ ol =] | sl
r
@ oK Cance!

| OK

Sla het bestand op en noem deze spijl.

| Controleer de invoer en sluit het venster.
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Samenstelling

Begin met een nieuwe samenstelling.

Activeer de knop om parameters te koppelen. Om de een
of andere duistere reden staat dit commando niet in het
pulldown menu, zoals bij de parts, maar alleen in de knop-
penbalk. Klik op de knop Link en kies opnieuw voor het
Excel bestand Hekwerk.xls. Sluit het venster met Done.

Klik op de knop om een component toe te voegen en voeg
twee liggers toe. Voeg daarna ook een enkele spijl toe.

Activeer de functie om plaatsvoorwaarden aan te brengen.
Zorg ervoor dat de twee liggers precies boven elkaar liggen
en dat de spijl door het eerste gat gaat. Voor de afstand
tussen de ligger en het einde van de spijl gebruikt u de
parameter SpijlAfstand van Excel. Controleer met “View >
Degrees of Freedom” of alle vrijheidsgraden weg zijn met
uitzondering van het draaien van de spijl.
S — ] ] ]

G|

Assembly | Moton | Trenstonal |

Type Selections
[F &lel|@m| kik:| ra T

Offset: Solution

[ spiafstand o @9 @

Fv T ABF
@ oK Cancal Apply

Activeer het commando om een component in een recht-
hoekig verband te kopiéren.

Klik op de spijl, daarna op de knop met het pijltje om aan
te geven dat u een andere vorm aangeeft waarlangs geko-
picerd wordt. Klik daarna op een van de gaten. In de
preview ziet u hoe het hek er uit komt te zien.

U heeft 50% kans dat het patroon de verkeerde kant uit
loopt. In dat geval breekt u deze functie af, u verandert de
plaatsvoorwaarde dat de spijl door het eerste gat loopt en
laat deze spijl juist door het laatste gat lopen.
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U had er ook voor kunnen kiezen dat u het aantal spijlen en
de richting opgeeft.

22 Assembly1

%= |§5 |8 | -
Feature Pattem Selact————————— L=
P T = |
g
oK Cancel 9
8| _oe | e | —
=
/A
< |

Controleer de invoer en sluit het venster.

Ga met de cursor naar de modelverkenner. Dubbelklik op
Hekwerk.xls. Verander de lengte van 300 naar 1000.
Bewaar het Excel bestand.

Klik op de knop om om de samenstelling bij te werken. Als
alles goed is gegaan, dan is het hekwerk nu 1 meter lang en
zijn er nieuwe spijlen bij gekomen.

=) Helowerk.iam

\
\
\
\
\
\
1\
v\

\
\

\

\

\
\

Sla de samenstelling op onder de naam Hekwerk.
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Tekening

Start met een nieuwe tekening op basis van millimeters.

Activeer de functie om een aanzicht te plaatsen. Plaats
Hekwerk.iam. Stel de schaal in op 1 op 4 en zet deze in het
midden van het papier.

Activeer de knoppenbalk voor de notaties en plaats enige
bematingen, zoals in de volgende afbeelding is aangegeven.
Controleer of u de bemating plaatst vanaf de eerste spijl.
Dit is element 1 van “Component Pattern 1”. Als u niet de
cerste, maar de laatste spijl van het patroon bemaat, dan
verdwijnt de maat als het rekje kleiner wordt.

Plaats een stuklijst. Dubbelklik op de stuklijst. Kies een
nieuwe kolom. In het scherm van de nieuwe kolom kiest u
voor een nieuwe Eigenschap. Type de parameter
AfkortLengte in. Type dit op precies dezelfde manier in als
u heeft gedaan bij het aanmaken van de parameters. Als u
alles goed heeft uitgevoerd, dan worden in de stuklijst de
afkortlengtes van de spijlen en de liggers getoond. Als de
afkortlengte niet voorkomt, dan is deze niet hetzelfde
gespeld, of dan is deze in het part niet gepubliceerd.
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1000
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©)
2 [ 10 Tspi [450 mm
1 |2 Tiigger [1000 mm
Nr | _Aantal | Onderdeel | AfkortLengte

8T

Controleer of de tekening in orde blijft bij andere waarden
van het Excel blad.

Tip: Als u dit systeem wilt gebruiken voor meerdere klan-
ten dan wilt u voor iedere klant zijn tekening bewaren.
Voordat u de tekening van de klant opslaat met “File >
Save Copy As", zet u het updaten uit met "Tools > Docu-
ment Settings > Drawing > Defer Updates”. De kopie van
de tekening wordt dan niet meer veranderd als het model
verandert.

Tip: Als u een tabel toevoegt en het Excel blad kiest, dan
kunt u de waarden die ingevuld zijn op de tekening plaat-
sen. Zo weet u exact welke invoer gepleegd is.



912

28.3

Theorie

Bestanden genereren

Pavametrisch tekenen

of modulair tekenen

Inventor 28 Variantenontwerp

iAssembly

Het gebruik van Excel heeft als beperking dat u geen
onderdelen kunt uitwisselen. Bovendien is het lastig om
een goede tekening uit te werken, omdat u tijdens het
bemating rekening moet houden met de verschillende
varianten. Een bekend probleem is dat een van de varianten
buiten het papier steekt.

Met een iAssembly zijn deze problemen overwonnen. Een
onderdeel in een iAssembly kan wel of niet:

B Onderdrukt worden

B Vastgezet worden

B Adaptief gemaakt worden

B Vervangen worden door een variant van een iPart

Verder kunt u nog een aantal minder vaak voorkomende
eigenschappen opnemen in de tabel van de iAssembly.

U kunt met een commando alle bestanden van alle varian-
ten van een iAssembly aanmaken. Daarna kunt u deze
gebruiken voor uw tekeningen alsof het een normale part
of assembly betreft.

Er zit ook een nadeel aan een iAssembly. U kunt alleen
werken met tabellen van vooraf gedefinieerde waarden. Het
is dus net alsof u met standaard modules werkt die u met
de iAssembly uitwisselt.

In de praktijk heeft de productie meestal liever modules in
plaats van willekeurig variérende maten. Dus waarschijnlijk
is een 1Assembly voor hun beter dan Excel.
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iIAssembly

Het voorbeeld van het hekwerk wordt in deze paragraaf
opnieuw uitgewerkt, maar nu met de techniek van de
iAssembly. De varianten van het hekwerk staan in de
volgende tekening beschreven.

2500

100,

= T I —T T [Horizontaal [ platstaal 20 » 5]

£ ===dfF S==iEEs) Verficaal [ rondt0 |

Hoogte Uitvoering
1000 1 bovenligger
1500 2 bovenliggers

Hoogte

1100,
_
—_
—_
—_
_

Start met een nieuw onderdeel op basis van millimeters.
Maak een schets van de ligger. Maak een strip van 25 * 5 *
2500. Plaats daarna om de 100 mm een gat van 10 mm.
Sla het onderdeel op. Noem het onderdeel Liggerl.

Start met een nieuw onderdeel op basis van millimeters.
Maak een spijl van rond 10 en hoogte 1000. Sla dit bestand
op onder de naam Spijll. Verander de spijl in een iPart.
Voeg de kolom voor de lengte van de spijl toe aan de tabel
van de iPart en voeg een rij toe met de lengte 1500. Veran-
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der ook de namen van de member en het part nummer
zoals in de volgende afbeelding is aangegeven.

=

iPart Author ]
Parameters | properties | Suppression | iMates | Work Features | Threads | Other |
7 spii Lipt ~ [ T [neme |
=-f@) Extrusiont :I 9 d1
H %= d0 [10 mm]
~x= d1[1000mm] — il
x= d2[0ceg] v
=] Member [ Parthumber | d1__|
T Spil 1000 mm Spj 1000 mm 1000 mm
2 [Spii 1500 mm Spijl 1500 mm [ _I
@I Options... verify Cancel
Sluit de dialoogbox.

Start met een nieuwe samenstelling.

Voeg drie maal Liggerl toe en eenmaal Spijll. Op het
moment dat u de spijl toevoegt wordt gevraagd of u de
variant wilt opslaan; bevestig dit.

Breng voldoende plaatsvoorwaarden aan. Zorg ervoor dat
de liggers op 100 mm van de uiteinden van de spijl liggen.
De afstand tussen de bovenste twee liggers is ook 100 mm.

£z Hekwerk1.iam

EEX

)
!

Gebruik opnieuw de functie om patroon van componenten
te plaatsen net zoals u in de vorige paragraaf heeft gedaan.
Als het patroon de verkeerde kant op loopt; laat dan de
spijl aan de andere kant van de ligger door het eerste gat
lopen.
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#= Hekwerk1.iam

\

\
5

Sla de samenstelling op onder de naam Hekwerkl.
Voordat u verder gaat, moet u weten welke ligger in het
midden ligt. Klik daarvoor in de verkenner op de drie

liggers.

Activeer het commando om de samenstelling om te zetten
naar een iAssembly. Het scherm dat verschijnt lijkt veel op
die van het iPart.

Voeg twee kolommen toe. De eerste kolom is de Eigen-
schap Include/Exclude van de middelste ligger. In de
afbeelding hieronder is dat Liggerl:2. De tweede kolom is
de tabel van Spijll.

iAssembly Author X

Components | parameters | Properties | Exclusion | iMates | BOM | Other
@ HeknerkLiam [ [ [Name [
) Ligger1:1 “  Ligger : 2:Indude/Exclude
=1 Ligger1:2 9, opjl 1:1:Table Replace

= Indlude/Exdude [Incude]

x= Grounding Status [Ungrounded]

= Adaptive Status [Non-Adaptive]
9 Liggert:3 2'
= @ spif 1:1

x= Grounding Status [Ungrounded]

x= Adaptive Status [Non-Adaptive]

%

Liggerl:Z: spijl 1:1:

‘“ Member PartMumber | 1o 4 defExclude | Table Replace

1 |Hekwerk1-01 Helwerk1-01 Indude Soil 1000 mm

A= = =

Voeg drie verschillende rijen toe. Dit zijn de verschillende
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alternatieven. Verander daarna de waarden van de verschil-
lende velden.

iggerl:2: ijl 1:1:
| e PartNumber | 1 jude /bxclude ‘ et
1 Hek 1000 mm Hek 1000 mm Exdude Spijl 1000 mm
2 Hek 1500 mm Hek 1500 mm Exdude Spijl 1500 mm
3 Hek 2 liggers 1000mm Hek 2 liggers 1000mm  :Indude Spijl 1000 mm
4 Hek 2 liggers 1500mm Hek 2 liggers 1500mm  :Indude I SE’E’I 1500mm - |

Controleer de invoer en sluit het venster.

Probeer de vier varianten uit.

Klik in de modelverkenner op de eerste variant, houdt de
shift-toets ingedrukt en klik op de laatste variant. Daarmee
zijn alle varianten geselecteerd. Klik nu op de rechter muis-
knop en kies uit het menu dat verschijnt voor het genereren
van de bestanden. Er worden dan twee mappen gemaakt
een voor het ipart en een voor de iAssembly. In de mappen
staan de verschillende varianten. Als dit eenmaal gebeurd is,
dan kunt u de varianten gebruiken in een tekening. Als u de
iAssembly wijzigt, dan dient u opnieuw de bestanden aan
te maken.

Activeer de stuklijst. Klik met de rechter muisknop op het
tabblad Structured en kies voor het tonen van de BOM



Inventor

Hek 1000 mm 'I

Model State |

Hek 2 liggers 1000 mm

28.3 iAssembly 917

view. Er verschijnt een keuzelijst in het menu van deze
dialoogbox. Met die keuzelijst kunt u de variant kiezen.

Kies een van de varianten van de iAssembly.

Bill of Materials [Hekwerk1.iam] EWEHXl
SR A AL M G B | [9 Rek1000mm 7] Shew cear |EE
Model Data e Structured | 2 All Members

Part Number

4 Hek 1500 mm QTY (Hek 1000 mm)
A Hek 2 liggers 1000mm
= Hek 2 liggers 1500mm
Spijl 1500 mm B Normal Eac

] ="

Sluit de dialoogbox van de BOM.

Start met een nieuwe tekening op basis van millimeters.

Activeer de functie om een aanzicht te plaatsen. Kies het
bestand Hekwerkl.iam. Stel de schaal in op 1 op 10.

Schakel om naar de instelling van het model.

Kies een van de varianten uit de lijst en zet deze in het
midden van het papier.

Conpanent. ModelState | iplay Options |
e o
e
e
i 5o
. .
et Cacioten
s
 Alsodes
con -
° e =)
== = sve
R gl || g e sEe r*
Bl [Fe x| o
M k-
[ e [ T
il I
. - —3— . . -

Omdat de varianten al gegeneerd zijn, hoeft u bij het
bematen niet speciaal op te letten op verdwijnende varian-
ten. Ook hoeft u niet Defer Updates aan te zetten.
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ﬂ Member selection

| Yes to All

| OK (2x)

Inventor 28 Variantenontwerp

Plaats een stuklijst. Dubbelklik op de stukljjst.

=E Edit Parts List

n|=| “|m| &
=] ]| ITEM [ oy | PART NUMBER I
1 3 Ligger1
H
= 2 24 Spijl 1000 mm
ﬁ 3 o Sﬂi 1500 mm Select Member to Indude
[~ ek 1000 mm
| Hek 1500 mm
[ Hek 2 liggers.
| Hek 2 liggers 1500mm
= o]

Yesto Al No to Al

9 Hide rows of zero quantity

Klik op de knop om de andere varian-
o)

ten ook toe te vocgen.

Klik op de knop om alle varianten toe te voegen.

Sluit beide vensters met OK. Dubbelklik daarna op de
stuklijst en pas de titels van de kolommen aan. Plaats ook
twee ballonnen. Een van de twee moet aangepast worden.

s \ s s s ¥ s ! . A
[N T Aartal ek 1000 rmm | Aantal ek 1500 mm | _Aantal ek 2 iggers 1000mm _[Aantal ek 2 iggers 1500mm| _Onderdeel |
[ 3 [ 0 | 24 I 0 I 24 [Spijl 1500 mm. |
| — 2 T 0 T 2 I 0 [Spi 1000 mm ]

Ll i I 2 I 2 [ 3 I 3 tiggert 1 [
q |c
- I
£ 3
A R e = A

e T I [ e T
=TT
5 T T T 5 3 T 3 T T
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EH Table |

N

| oK

28.3 iAssembly 919

Activeer het commando om een tabel te plaatsen.

Klik op het aanzicht van het hekwerk.

Source Table Column Chooser

B, | select view Avaiabe Corms:
C: \Documents and Settings
Columns and Rows
|  column chooser
Selected Columns

Iy Member New Column Move Down Move Up
oK Cancel
@

Klik op de knop om meerdere kolommen toe te voegen.
Kies de kolom die bepaalt of de tweede ligger wordt
uitgesloten en de kolom die de iPart bepaalt..

Klik twee maal op OK. Als u daarna dubbelklikt en de
kolommen andere namen geeft, dan ziet de tekening er als

. . . s ¥ B | . L
[T Aantal ek 1000 mm | Aantal ek 1500 rm [ Aartal Hek 2 ggers 1000mm | Aantal ek 2 iggers T500mm| _ Onderdesi |
—s 1 0 I 2 I 0 I 24 55311500 mm |
—= 1 2 I 0 I 2 I 0 [Spy1 1000 mm I
Ll 1 I 2 [ 2 [ 3 I 3 [Giggert ] P
@\z,a
q lc
== K-
£ 3
A e e = n
e T [ [ Faw T
=TT
3 T T T L3 3 T T T
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Diverse

Inventor of Een hekwerk is niet echt een complexe samenstelling.
Voor dit soort gevallen kunt u beter AutoCAD gebruiken.
De dynamische blokken en de lagen van AutoCAD zijn
niet zo krachtig als die van Inventor, maar krachtig genoeg
voor dit voorbeeld.

AutoCAD

Een Dynamisch blok van AutoCAD is sneller te maken dan
een parametrisch model van Inventor. Het tekeningbeheer
voor AutoCAD is stukken eenvoudiger omdat een samen-
stellingstekening niet athankelijk is van allerlei andere
bestanden.

Ontwerp op maat vin  Voor een ontwerp op maat wordt de volgende procedure
gesuggereerd. De klant voert zijn bestelling in op een html
pagina. Er wordt een mail gestuurd naar de computer
waarop Inventor staat. Outlook herkent de mail en past via
VBA het rekenblad van Excel aan. Outlook start Inventor
en naderhand wordt de tekening teruggezonden.

Internet

S

[[rerner asp]
Klant of verkoper] . = [outiook VEA [
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